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Guide for WOAH Members and International Organisations on submitting 
comments during the Process for the elaboration of WOAH International 
Standards 

WOAH has developed a Standard Operating Procedure (SOP) for the submission of comments by 
WOAH Members and International Organisations with a cooperation agreement with WOAH (IOs) 
during the Process for the elaboration of WOAH International Standards. Its purpose is to improve the 
transparency, documentation, and traceability of the process for receiving and responding to comments 
submitted by WOAH Members and IOs on the work to develop and review WOAH Standards. The SOP 
also describes the roles and responsibilities of WOAH Members and International Organisations, 
Specialist Commissions, subject-matter experts, and WOAH Headquarters, during the process.  

This document should be read in conjunction with the SOP and provides guidance for Members and IOs 
on how to submit and present comments for consideration by WOAH Specialist Commissions. 

The process for the elaboration of WOAH International Standards 

Every year the WOAH World Assembly adopts new or revised International Standards at the General 
Session. The standards proposed for adoption are the result of comprehensive work undertaken by 
WOAH Specialist Commissions, with the support of subject-matter experts and the WOAH Secretariat.  

Members and IOs play a key role in the process of developing new or revising existing standards. 

Members and IOs are also encouraged to submit comments on the work plan of the Specialist 
Commissions to develop or review standards, which are presented in the meeting reports of the 
Specialist Commissions.  

The Specialist Commission meeting reports include a main section that documents discussions and 
conclusions reached during a specific Specialist Commission meeting. In addition, the reports also 
include a series of annexes, each of which presents a proposed new or revised standard that is 
circulated for comment. The reports are published in the three WOAH official languages (English, French 
and Spanish) and include links to other relevant reports, such as other Specialist Commissions, Working 
Groups, and ad hoc Groups. The Specialist Commission reports are published on the WOAH website 
and on the Delegates website. These documents are available in MS Word format (“.doc”) on the 
Delegates website to facilitate the commenting process; IOs can request them from the Secretariat 
(email specified below). 

Specialist Commission reports are published twice a year after the Specialist Commission meetings, 
which are held in February and September. 

Proposed new or revised standards are circulated for comment in the respective Specialist Commission 
reports as follows: 

- the Aquatic Animal Health Standards Commission (AAHSC) for the Aquatic Code and Aquatic 
Manual; 

- the Biological Standards Commission (BSC) for the Terrestrial Manual; 

- the Terrestrial Animal Health Standards Commission (TAHSC) for the Terrestrial Code. 

Members and IOs are encouraged to participate in the WOAH Standards-setting process by submitting 
comments on the circulated new or revised standards. The responsible Commission’s response to 
comments or proposals considered is documented in the relevant Specialist Commission meeting 
report. 

https://oieoffice365.sharepoint.com/sites/DEPStandardsFiler/Shared%20Documents/Trade/Internships/2023%20Luciana%20Cozzolino/1.%20SOPs/2nd%20SOP/Guidelines/1.1%20Reference%202%20TAHSC-AAHSC%20Guidelines.docx
https://www.woah.org/en/what-we-do/standards/standard-setting-process/scientific-commission/
https://oieoffice365.sharepoint.com/sites/OIEDelegatewebsite/SitePages/en/Home.aspx?e=1%3Ac1c7fb2a424c425598536856356c4842
https://www.woah.org/en/what-we-do/standards/codes-and-manuals/#ui-id-3
https://www.woah.org/en/what-we-do/standards/codes-and-manuals/#ui-id-4
https://www.woah.org/en/what-we-do/standards/codes-and-manuals/#ui-id-2
https://www.woah.org/en/what-we-do/standards/codes-and-manuals/#ui-id-1
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The reports of the Scientific Commission for Animal Diseases (SCAD) is not intended for comment but 
usually document elements that should be considered together with the report of the TAHSC.  

Commenting during the Process for the elaboration of WOAH International Standards 

What is ‘commenting’?  

‘Commenting’ is the specific mechanism for Members and IOs to express their opinions on Specialist 
Commissions’ work to develop new or revise WOAH Standards (as presented in the Specialist 
Commissions’ reports) before they are proposed for adoption at a General Session.  

Who can comment? 

Comments can only be submitted by WOAH Members, through their WOAH Delegate, and IOs with 
which WOAH has a cooperation agreement.  

What to comment on? 

WOAH Delegates and IOs can comment on all items of interest in a Specialist Commission’s report 
(either in the body of the report or in the annexes) or only on those items deemed relevant to their 
national context.  

Members and IOs can: 

- request new work to be undertaken; 

- support or object to work items in a Specialist Commission work programme; 

- comment on the priority of work items in a Specialist Commission work programme; 

- raise points of interest for work items in a Specialist Commission work programme and provide 
information, evidence or expertise that could be taken into consideration for the development of the 
work (especially for ones that have not yet started or are in preparation); 

- review and contribute to the development of proposed texts circulated for comment, by: 

• proposing amendments to incorporate new or additional evidence that supports the proposed 
amendments; or 

• suggesting additional or alternative science-based provisions to improve or complement a 
proposed text; 

• proposing amendments to a proposed text to address evidence-based concerns on potential 
challenges for their implementation under specific conditions or contexts (e.g. Members, regions, 
species);  

• proposing amendments to address wording issues that could compromise the understanding or 
the meaning of the texts, in any of the three languages. 

When to comment? 

Members and IOs must submit comments before the deadline indicated in the published report of the 
AAHSC, the TAHSC or the BSC, respectively. 

Delegates are encouraged to involve national experts, as well as the relevant WOAH National Focal 
Points in the consideration of the Specialist Commissions reports, to support him/her in the preparation 
of the national comments.  
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Delegates are also strongly encouraged to undertake a consultation with relevant stakeholders (e.g. 
private sector, NGOs, and other governmental organisations) relevant to their national context.  

How to present comments? 

WOAH Delegates and IOs should prepare, format, and submit comments as per guidance provided in 
this document as follows:  

• If comments refer to a work programme or items documented in the report that do not include 
annexes in a Specialist Commission report, follow guidance provided in Section 1;  

• If comments refer to a proposed new or revised text that was circulated for comment in a 
Specialist Commission report, follow guidance provided in Section 2. 

How to submit comments? 

Comments should be submitted by email to the Secretariat of the responsible Specialist Commission, 
as provided in the relevant Specialist Commission report, as follows: 

• Aquatic Code and Aquatic Manual (AAHSC) AAC.Secretariat@woah.org 

• Terrestrial Code (TAHSC) TCC.Secretariat@woah.org  

• Terrestrial Manual (BSC) BSC.Secretariat@woah.org 

All comments addressed to one Specialist Commission should be included in a single email containing 
all relevant files.  

Files must be sent in MS Word (.doc) format.  

If convenient, files could be grouped into one compressed file (.ZIP).  

  

mailto:AAC.Secretariat@woah.org
mailto:TCC.Secretariat@woah.org
mailto:BSC.Secretariat@woah.org
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Section 1 

Commenting on the work programme or items documented in the report that do not 
include annexes 

WOAH Delegates and IOs should follow the processes described below and submit comments using 
Form A to comment on the Specialist Commission work programme or items documented in the report 
that do not include annexes. 

In addition, consider the following: 

1) How to prepare to comment  

WOAH Delegates and IOs should identify the items of interest either in the body of the report or in the 
annex on the work programme.  

Before preparing comments, it is important to read the details provided in the body of the relevant 
Specialist Commission report, for topics of interest.  

The Specialist Commission reports also include detailed information about previous discussions and 
other relevant reports (e.g. other Specialist Commissions, WOAH ad hoc Groups or Working Groups) 
that should also be considered when preparing comments, to ensure the relevant context into account 
and to avoid repeating previous discussions. 

2) Preparing the file 

One single file should contain all comments submitted by a Member or IOs. 

Before drafting the comments, copy and paste Form A into a MS Word file (.doc).  

In the second line of the table, indicate the name of the Member or IO submitting the comments, the 
Specialist Commission, the report being commented on (February or September), and the year. If the 
comment is submitted on behalf of several Members, this should be explicitly mentioned for each 
relevant comment.  

Name the file using the following code: [Member/IO name]_[report: Sept or Feb]_[year] (e.g. 
Canada_Feb_2023), and save the file.  

If the comments are more than three, you may add new rows at the end of the table. For that, click inside 
the last cell of the table, and, on the ‘Layout’ tab, click ‘Insert Below’ in the ‘Rows and Columns’ group.  

 

3) Presenting the comments 

For each comment, the following parts must be provided in the table.  

  



 
December 2023 5 

 
a) Title of the Item in the report or Item in the work programme annex 

Each comment should specify the specific item (title and number) to which the comment refers: 

• if the comments are on a part of the report, for which there is no annex, include the item 
number and the title of the item as presented in the report;  

• if the comments refer to the work programme, include the name of the chapter/title/work as 
noted in the work programme itself;  

• if the comment requests/proposes a new work that is not included in the work programme, 
it is not necessary to populate this part.  

b) Proposal or comment 

The proposal or comment should be clearly explained in less than 100 words.  

These should include a clear suggestion or request to the responsible Specialist Commission.  

WOAH Delegates and IOs can use the form A to: 

• request new work to be undertaken; 

• support or object to work items in a Specialist Commission work programme; 

• comment on the priority of work items in a Specialist Commission work programme; 

• raise points of interest for work items in a Specialist Commission work programme and 
provide information, evidence or expertise that could be taken into consideration for the 
development of the work (especially for ones that have not yet started or are in preparation); 

c) Rationale 

Members and IOs must explain the rationale to support their proposal/comment.  

Each comment should be supported by a brief, but clear, explanation of the reasoning or 
justification for the proposal being made, in less than 200 words. The rationale should take 
into consideration the relevant background for the work (e.g. AHG reports, previous SC 
reports), and include references to documented evidence when relevant. 

d) Supporting evidence 

Where relevant to support the rationale, documented evidence should be provided in the box 
itself. This could be scientific references, evidenced-based reports, or national and 
international situation reports.  

In all cases, Members and IOs are encouraged to: 

• provide accessible links to the documents; or  

• insert the documents (PDF files) to this part (i.e. using MS Word, from the ribbon you may 
find: “Insert>Text>Object>Create from file”. Then browse the file of interest, use “Display 
as an icon” and validate with “ok”).  

An example of how to present comments can be found in Appendix I.  
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FORM A 

COMMENTS ON THE WORK PROGRAMME OR ITEMS DOCUMENTED IN THE REPORT THAT DO NOT 
INCLUDE ANNEXES 

Name of Member or 
IO: 

 

Commission report and date of report:  

 Title of the item in the report or item in the work programme annex: 

 

Proposal/Comment: 

 

Rationale:  

 

Supporting evidence, if relevant: 

 

 Title of the item in the report or item in the work programme annex: 

 

Proposal/Comment: 

 

Rationale:  

 

Supporting evidence, if relevant: 

 

 

 Title of the item in the report or item in the work programme annex: 

Proposal/Comment: 

 

Rationale:  

 

Supporting evidence, if relevant: 
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Section 2 

Commenting on new or revised standards circulated for comment as annexes 

WOAH Delegates and IOs should follow the processes described below and use the following form to 
comment on new or revised standards circulated for comment as annexes.  

NOTE: Comments not respecting this guidance may not be taken into consideration by the Specialist 
Commission. 

In addition, consider the following: 

1) How to prepare to comment 

WOAH Delegates and IOs should identify the subjects of interest in the main body of the Specialist 
Commission report and the corresponding annexes.  

Before preparing specific comments, it is important to read the full body of the report, with a special 
focus on the specific parts of the topics of interest.  

The Specialist Commission reports include detailed information on previous discussions and associated 
reports that should also be considered when preparing comments, to ensure the relevant context into 
account and to avoid repeating previous discussions. 

2) Preparing the files 

Once the items of interest have been selected, WOAH Delegates can download the relevant annexes 
in Word format from the WOAH Delegates Website. If IOs with a cooperation agreement need the files 
in this format, please contact the WOAH Secretariat.  

One single file per annex should contain all comments from a given Member/IO. If some comments are 
submitted on behalf of several Members, this should be explicitly mentioned for each relevant comment.  

3) Presenting the comments 

Comments should be grouped by annex. All comments from a submitter on an annex must be included 
‘inside’ the relevant annex (in MS Word format).  

Comments should be submitted in English, French, or Spanish. 

Each comment should be made in using a double-column table (‘comment table’). Members and IOs 
must insert each table containing a comment on the text just below the paragraph under consideration. 
If the comment pertains to an entire chapter or multiple sections within a chapter, it should be positioned 
at the beginning of the respective annex. 

Each ‘comment table’ must contain the following: 

• In the left column, the name of the Member or IOs submitting the comment. If the comment is 
submitted on behalf of several Members, this should be explicitly mentioned for each relevant 
comment. 

• In the right column, the comment, which should include all the elements described below (comment 
category, suggested alternative text (or precise suggested deletion), and rationale and supporting 
evidence). 

The “comment table” must follow the format presented below (this table can be copied and pasted into 
the working file): 
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Name of 
Member or IO 

Category (addition, deletion, change, editorial, general): 

 

Proposed amended text (or precise suggested deletion):  

 

Rationale: 

 

Supporting evidence, if relevant (e.g. scientific references, national and 
international reports, tangible experiences in this regard attached to this table)  

 

 

Comments should only refer to the text proposed in the annex. Comments should not be submitted on 
comments previously addressed by the Commission unless additional supporting evidence is provided.  

Comments must not mention other Members comments and should not name other Member and 
territories. 

For each comment, the table must contain the following elements: 

a) Comment category 

Only the following categories should be used: 

• Addition: when proposing to add new content 

• Deletion: when proposing to remove proposed content;  

• Change: when proposing to modify the proposed content (meaning); 

• Editorial: when proposing to address formatting issues and to improve language, including 
translation without altering the meaning of the proposed content; 

• General Comment: in this category, the table should be positioned at the beginning of the 
annex and the comment should be on the whole text, rather than focusing solely on a specific 
paragraph.  

Members and IOs are responsible for categorising each comment submitted to facilitate the 
Specialist Commission’s understanding of the comment. 

b) Proposed amended text 

Members and IOs must suggest an alternative text that would address their concerns. To this end, 
Members and IOs should include the relevant word or phrase of the original text circulated for 
comment and use a blue font to show the proposed alternative text.  

DO NOT use the automatic ‘track-changes’ function in MS Word. 

Apply strikethrough formatting to indicate suggested deletions.  

Apply double underline to proposed additions. Do not use the highlight feature for suggested new 
text, but instead, use blue font. (NB: these elements are found in MS Word in font settings).  



 
December 2023 9 

c) Rationale  

Members and IOs must explain the rationale to support their proposal/comment.  

Each comment should be supported by a brief, but clear, explanation of the reasoning or 
justification for the proposal being made, in less than 200 words. The rationale should take into 
consideration the relevant background for the work (e.g. AHG reports, previous SC reports), and 
include references to documented evidence when relevant. 

d) Supporting evidence 

Where relevant to support the rationale, documented evidence should be provided in the “comment 
table”. This could be scientific references, evidenced-based reports, or national and international 
situation reports.  

In all cases, Members and IOs are encouraged to: 

• provide accessible links to the documents; or 

• insert the documents (PDF files) into the “Supporting evidence” section. When using MS Word, 
in “the ribbon” you may find: “Insert>Text>Object>Create from file”. Then browse the file of 
interest, use “Display as an icon” and validate with “ok”.  

Examples of how to present comments can be found in Appendix II.  
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APPENDIX I 

EXAMPLE: Comments from ‘Wonderland’  

FORM A 

COMMENTS ON THE WORK PROGRAMME OR ITEMS DOCUMENTED IN THE REPORT THAT DO NOT 
INCLUDE ANNEXES 

Wonderland  Code Commission September 2022 

 Title of the item in the report or item in the work programme annex: 

Work programme: revision of Chapter 14.8. Scrapie. 

Proposal/Comment: 

Wonderland further encourages WOAH to request that the ad hoc Group of 
experts further consider the use of genetic resistance and/or live animal testing 
as valid methods for allowing the safe trade of sheep and goats between 
countries.  

Rationale:  

The scientific evidence (see references below) supports other methods to 
mitigate risk and prevent spread of scrapie: 

1. González L, Pitarch JL, Martin S, Thurston L, Simmons H, Acín C, Jeffrey 
M. Influence of polymorphisms in the prion protein gene on the 
pathogenesis and neuropathological phenotype of sheep scrapie after oral 
infection. J Comp Pathol. 2014 Jan;150(1):57-70. doi: 
10.1016/j.jcpa.2013.10.001. Epub 2013 Oct 10. PMID: 24342584. 

2. Jeffrey M, Martin S, Chianini F, Eaton S, Dagleish MP, González L. 
Incidence of infection in Prnp ARR/ARR sheep following experimental 
inoculation with or natural exposure to classical scrapie. PLoS One. 2014 
Mar 10;9(3):e91026.  

3. McIntyre KM, Gubbins S, Goldmann W, Hunter N, Baylis M (2008) 
Epidemiological characteristics of classical scrapie outbreaks in 30 sheep 
flocks in the United Kingdom. PLoS One 3(12): e3994. 

4. Dennis MM, Thomsen BV, Marshall KL, Hall SM, Wagner BA, Salman MD, 
Norden DK, Gaiser C, Sutton DL. Evaluation of immunohistochemical 
detection of prion protein in rectoanal mucosa-associated lymphoid tissue 
for diagnosis of scrapie in sheep. Am J Vet Res. 2009 Jan;70(1):63-72.  

Supporting evidence: 

 

 Title of the item in the report or Item in the work programme annex: 

Work programme: revision of Chapter 8.10. Japanese encephalitis. 

Proposal/Comment: 

Wonderland requests that this work item be changed to a Priority 1 for review. 
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Rationale: considering recent disease events. 

Supporting evidence: 

Japanese encephalitis - WOAH - World Organisation for Animal Health 

 Title of the item in the report or Item in the work programme annex: 

Work programme – New proposal. 

Proposal/Comment: 

Wonderland request the Code Commission to consider reviewing Chapter 
10.2. Avian infectious bronchitis, particularly Article 10.2.3.  

Rationale: As currently presented, the article is not clear as whether the 
provisions in the article are alternative or complementary, and consequently it 
is not clear on how the measures should be applied in the case of vaccinated 
populations. This lack of clarity is causing problems to agree measures for 
international trade with trading partners.  

Supporting evidence: not relevant.  

 Title of the item in the report or Item in the work programme annex: 

Report – Item 4.2.5. New chapter on Biosecurity 

Proposal/Comment: 

Wonderland fully supports the decision of the Code Commission to develop a 
new Chapter on Biosecurity and supports the approach proposed by the AHG. 
Wonderland would like to emphasise the need for this work to take into 
consideration the risks posed by arthropod vectors and the importance on 
ensuring that biosecurity plans take them into consideration. Similarly, the 
importance of biosecurity to protect the health of personnel and human 
populations should be duly covered.  

Rationale: see attached supporting evidence. 

Supporting evidence:  

 

 

https://www.woah.org/en/disease/japanese-encephalitis/
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APPENDIX II 

EXAMPLE A: Comments from ‘Wonderland’  

C H A P T E R  1 1 . 4 .  
 

I N F E C T I O N  W I T H  M A R T E I L I A  R E F R I N G E N S  

Wonderland Category: General  

Proposed amended text: not suitable. 

Rationale: Wonderland fully support the proposed changes to this Chapter 
since were needed. 

Supporting evidence: not relevant 

 

Article 11.4.1.  

For the purposes of the Aquatic Code, infection with Marteilia refringens means infection with the pathogenic 
agent M. refringens of the Family Marteiliidae. 

Wonderland Category: Addition 

Proposed amended text: For the purposes of the Aquatic Code, infection with 
Marteilia refringens means infection with the pathogenic agent M. refringens and 
M. pararefringens of the Family Marteiliidae. 

Rationale: It needs to be clear that this includes all forms of Marteilia refringens, 
whether this is the O and M type or other forms such as the more recently 
proposed new species of M. pararefringens (Marteilia pararefringens Kerr R et al 
(2018)), a species that infects the Blue mussel (Mytilus edulis Kerr et al., 2018). 

Supporting evidence: 

Kerr 2018_2.pdf Kerr 2018.pdf

 

 

Information on methods for diagnosis is provided in the Aquatic Manual. 

Article 11.4.2.  

Scope 

The recommendations in this chapter apply to: blue mussel (Mytilus edulis), dwarf oyster (Ostrea stentina), 
European flat oyster (Ostrea edulis), European razor clam (Solen marginatus), golden mussel (Xenostrobus 
securis), Australian mud oyster (Ostrea angasi), Argentinean oyster (Ostrea puelchana), Chilean flat oyster (Ostrea 
chilensis), blue mussel (Mytilus edulis) and Mediterranean mussel (Mytilus galloprovincialis) and striped venus 
(Chamelea gallina). These recommendations also apply to any other susceptible species referred to in the Aquatic 
Manual when traded internationally. 
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Wonderland Category: Editorial 

Proposed amended text: (Ostrea stentina), European flat oyster… 

…and striped venus clam (Chamelea gallina). 

Rationale: Insertion of “clam” is required here as it is part of the common name for 
Chamelea gallina. 

Supporting evidence: not relevant 

 

[…] 
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EXEMPLE B: Comments from ‘Wonderland’ 

C A P Í T U L O  1 1 . 1 0 .  
  

I N F E C T I O N  W I T H  T H E I L E R I A  A N N U L A T A ,  
T .  O R I E N T A L I S  A N D  T .  P A R V A   

Article 11.10.1. 

General provisions 

Animals susceptible to infection with Theileria are bovines (Bos indicus, B. taurus and B. grunniens), water buffaloes 
(Bubalus bubalis), African buffaloes (Syncerus caffer), sheep (Ovis aries), goats (Capra hircus), camels 
(CamelCamelus dromedarius and C. bactrianus) and some wild ruminants. 

Wonderland  Category: Editorial  

Proposed amended text:  

Animals susceptible to infection with Theileria are bovines (Bos indicus, B. taurus 
and B. grunniens), water buffaloes (Bubalus bubalis), and African buffaloes 
(Syncerus caffer), sheep (Ovis aries), goats (Capra hircus), camels (Camel 
dromedarius and C. bactrianus) and some wild ruminants. 

Rationale: Water and African buffaloes are also bovines. 

 

Infection with Theileria can give rise to disease of variable severity and to Theileria transmission. Theileria may 
persist in ruminants for their lifetime. Such animals are considered carriers. 

Wonderland Category: Editorial  

Proposed amended text: 

 Animals susceptible to infection with Theileria areTheileriosis is a disease of bovines 
(Bos indicus, B. taurus and B. grunniens), water buffaloes (Bubalus bubalis), African 
buffaloes (Syncerus caffer), sheep (Ovis aries), goats (Capra hircus), camels (Camel 
dromedarius and C. bactrianus) and some wild ruminants. 

Infection with Theileria can give rise to disease of variable severity and to Theileria 
transmissionSome Theileria species are considered highly pathogenic, while others 
are scarcely or not pathogenic. Theileria may persist in ruminants for their lifetime. 
Such animals are considered carriers. 

Rationale: To clarify that the first two paragraphs provide general description of 
Theileriosis that includes not only sheep and goat diseases but also others, and to avoid 
to use ‘infection with Theileria’ in these paragraphs, considering the definition for 
‘Theileria’ described in the fourth paragraph. The proposed text in the second paragraph 
is extracted from the Terrestrial Manual chapter.  

Supporting evidence: not relevant 

For the purposes of the Terrestrial Code, infection with Theileria annulata, T. orientalis and T. parva are is defined 
as a tickborne infection of bovines and water buffaloes with T. annulata, T. orientalis Ikeda, T. orientalis Chitose 
andor T. parva. 
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For the purposes of this chapter, Theileria means T. annulata, T. orientalis Ikeda, T. orientalis Chitose and T. parva. 

The following defines the occurrence of infection with Theileria: 

1) Theileria has been identified in a sample from a bovine or water buffalo; or  

2) antigen or nucleic acid specific to Theileria has been identified in a sample from a bovine or water buffalo 
showing clinical signs consistent with infection with Theileria, or epidemiologically linked to a suspected or 
confirmed case, or giving cause for suspicion of previous association with Theileria; or 

3) antibodies specific to Theileria have been detected in a sample from a bovine or water buffalo that either 
showsshowing clinical signs consistent with infection with Theileria, or is epidemiologically linked to a 
suspected or confirmed case or giving cause for suspicion of previous association with Theileria. 

Wonderland  Category: Addition  

Proposed amended text: 

3) antibodies specific to Theileria, that are not a consequence of vaccination, 
have been detected in a sample from a bovine or water buffalo that either 
shows clinical signs consistent with infection with Theileria, or is 
epidemiologically linked to a suspected or confirmed case or giving cause for 
suspicion of previous association with Theileria. 

Rationale: For consistency with other case definitions in the Code. 

Supporting evidence: not relevant 

 

For the purposes of the Terrestrial Code, the incubation period for infection with Theileria shall be 35 days. 

Standards for diagnostic tests and vaccines are described in the Terrestrial Evidencia documentada:. 

[…] 
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